Contents

General Information 1
Competition components 2
Case Comment 2
Materials 3
Case Comment Format 3
Case Comment Scoring 4
Bluebook and Editing Exam 4
Personal Statements 5
Redacting Personal Statements 5
Removing Personal Data 6
Removing Personal Data in Word 2013 (Office 365) 6
Removing Personal Data in Word 2010 (Windows) 6
Removing Personal Data in Word 2007 (Windows) 7
Removing Personal Data in Word 2016 (Mac) 7
Removing Personal Data in Word 2011 (Mac) 7
Removing Personal Data in Apple Pages 5 (Mac) 7
Submitting Documents 7
Preferencing 8
Frequently Asked Questions 9
GENERAL INFORMATION

● For 2021, the Competition occurs between 9am EDT May 21 and 11:59pm EDT July 7.
   ○ Students pick a 2-week window to compete
   ○ Time starts once student has agreed to terms
   ○ $40 will be charged to your student account
● Closed packet; limited to the materials provided and general reference materials like the Bluebook
● Packet number assigned at Competition start; use this as your identifier on all submissions
● Preferencing will be open through July 7 regardless of your individual deadline
● Results expected late July
● Contact only the Office of Journal Administration (lawwriteon@georgetown.edu) during the Competition.
   ○ Office of Journal Administration (OJA) will be available by email during business hours (M-F 9am - 5pm EDT)

COMPETITION COMPONENTS

● Case Comment (required for all, must be completed within your 2-week window)
● Bluebook and Editing exam (required for all, must be completed within your 2-week window)
● Grades (provided by the Registrar)
● Personal Statement (required by some, must be completed within your 2-week window)
● Preferencing (required, may be completed any time before 11:59pm EDT, July 7)

CASE COMMENT

● You may use only the following materials to write your Case Comment:
   ○ Materials included in the Write On Packet
   ○ The “How to Write a Case Comment” packet (including PowerPoint presentation and Word file)
   ○ The sample comment from the 2020 Write On Competition on the OJA website
   ○ A dictionary (both standard and legal)
   ○ A thesaurus
   ○ Computerized spell check programs
   ○ The 21st Edition of the Bluebook (print or online edition)
● You may not:
   ○ Use notes or materials from a class, job, or other activity
   ○ Use Westlaw or Lexis for the purpose of writing the Case Comment
   ○ Access documents linked from but not included in the competition materials
- Conduct any other outside research
- Discuss the contents of the Competition with anyone during the Competition.

- You may use Westlaw, Lexis, etc. for your job, but not for any research related to the Case Comment.
- Contact Mara Bellino, the Disabilities Services Coordinator at Georgetown Law, at (202) 662-4042 or mcb260@georgetown.edu, if you need any accommodations for a disability to participate in the Write On Competition.
- Contact the Office of Journal Administration at lawwriteon@georgetown.edu for any other questions.
- Students with a deferred exam may not begin the competition until 24 hours after the submission of their last exam.

MATERIALS

- All materials will be available on the competition website once you have agreed to the terms.

CASE COMMENT FORMAT

- Times New Roman, 12-point only (for both the text and the endnotes).
- The text must not exceed 7 pages and the endnotes must not exceed 3 pages.
- Text should be double-spaced (unless the Bluebook requires single spacing—as for long quotations) so that you have no more than 26 lines of double-spaced text.
- The endnotes must be single-spaced with a blank line between each note. Each page of endnotes may have no more than 52 lines total of print and spacing.
- Please include a title page that lists your case comment title and packet number. The title page does not count towards the page limits described above.
- You must leave a one-inch (1") margin on all four sides of the page (not including page numbers). Check your document’s page layout settings, as some programs might default to different margins.
- Extra pages and/or extra notes may be counted against your score.
- You may wish to convert your final paper to .pdf to preserve formatting
  - Check your final conversion before submitting
- A case comment should include the following elements although you are not restricted to this formula:
  - The facts of the case (approximately 2 pages or less), relevant facts and procedural history.
  - Holding (approximately 1 page or less) and your analysis of the holding in the principal case.
  - Roadmap (approximately ½ page) explaining the structure of the comment.
  - Analysis (the balance).
  - Conclusion (approximately ½ page).
- Concentrate on your most compelling criticisms and observations and, most importantly, offer your solution to the legal problem(s) presented and the reasoning behind the solution(s) you have chosen.
• Assume the audience is an educated but non-expert reader, with no specific knowledge of the subject matter
• Focus on a single narrow or novel issue presented by the principal case
• Provide some depth to the reader to explain both the specific issue and your assessment.
• You do not need to cite to all the sources
• For further guidance on how to write a case comment, please refer to the How to Write a Case Comment packet, How To slides, or How To session transcript.

CASE COMMENT SCORING
• Each case comment is scored by 3 judges, each from a different journal
  ○ Judges are rising 2nd-year journal members
  ○ Judges may or may not be members of journals you preference
• The three scores are averaged for a total Case Comment score
• You will not receive judge comments or scores after the Competition
• Case Comments are scored in the following areas:
  ○ Analysis - 18 pts
  ○ Structure - 12 pts
  ○ Bluebooking - 10 pts
  ○ Creativity - 2 pts
  ○ Administrative Precision - 8 pts
• A sample score sheet is provided for reference in the Downloads section of the Competition site

BLUEBOOK AND EDITING EXAM
• The Exam consists of a short excerpt from an unpublished student note.
  ○ 25 points for editing the text
  ○ 25 points for Bluebooking
• Specific instructions are given with the Exam
• Use Track Changes for the editing portion
• Submit the exam as a Word file
• Spacing doesn’t count
• Be as specific as possible in your editing comments.
• Your score for the editing portion will be the total, up to 25 points, of the correct edits you make. You will not be penalized for marking more than 25 edits.

PERSONAL STATEMENTS
• Some journals weigh a personal statement and/or resume as part of your overall competition score
- Journals Comparison Chart shows all journal weights
- Letters from the Editors will tell you what to submit for each journal

REDACTING PERSONAL STATEMENTS

- Remove personal data and redact identifying information from submissions
- Identifying information may include:
  - your name and any contact information
  - any positions you hold in Georgetown Law organizations
    - Law Fellows – list but do not identify day or night division
    - RAs – just list that you will be an RA for the summer, not who you are working for
  - any awards that would be obviously traceable back to you
  - the name and city of your undergraduate institution
  - any publication titles and citations
  - the name of your summer firm
  - anything else that would be searchable or otherwise common knowledge in the student body
- Consider including a brief note describing the nature of a redacted item.
  - For instance, if your undergraduate thesis is titled, “Three Things Very Dull Indeed: Class, Poverty, and Welfare in Jane Austen’s England”, you might need to redact the title but add, “used the novel Emma as a springboard for exploring the pernicious and pervasive problem of poverty in early 19th-century England”.
- Recommended ways to redact:
  - Use Adobe Acrobat’s redaction tool
  - Write around the missing text (e.g., “Undergraduate University” instead of “Georgetown University”)
  - Replace the text with x’s (e.g., “xxxx xxxx News” instead of “Yale Daily News”)
  - Use [Redacted] (e.g., “[Redacted thesis title]”)
- A good rule of thumb is to remove or obfuscate anything that would lead directly to you in a Google search.
- We understand that these guidelines can be quite subjective or may be difficult to follow in certain circumstances without removing all personality from a submission. We ask that you make your best effort, and OJA will review all submissions before sending to the editors.
- Be deliberate about the information you provide to journals; it will help you write around any personally identifying information you might have to redact.

REMOVING PERSONAL DATA

- You must remove personal identifying information from every file you upload as part of the Competition.
- You must also redact any resumes and personal statements.
• Instructions for removing this information from Microsoft Word 2016 and older versions are given below.
• Students using other word processing software are responsible for determining how to remove this personal identifying information.
• Remove all identifying information before converting to .pdf.

REMOVING PERSONAL DATA IN WORD 2013 (OFFICE 365)
1. Open the Microsoft Word 2013 document.
2. Click on the File tab.
3. Choose the Options option.
4. The Word Options dialog will open.
5. Delete the information within the User Name field and press the Space key once.
6. Delete the information within the Initials field and press the Space key once.
7. Click on the OK button.

Note: You must have one blank space in both the User Name and Initials fields, as Microsoft Word needs "text" in those fields. If you do not press the Space key, your name and initials will return.

REMOVING PERSONAL DATA IN WORD 2010 (WINDOWS)
1. Click on the File menu and click Info from the left sidebar.
2. Click Check for Issues and select Inspect Document. A Document Inspector window will open.
3. Click Inspect.
4. Click Remove All in the section for Document Properties and Personal Information (NOT Header, Footer, and Watermarks), then click Close.

You can also do the following:
1. Open a Microsoft Word document.
2. Click on the File tab.
3. Choose the Options option.
4. The Word Options dialog will open. (Please see the image below.)
5. Delete the information within the User Name field and press the Space key once.
6. Delete the information within the Initials field and press the Space key once.
7. Click on the OK button.

Note: You must have one blank space in both the User Name and Initials fields, as Microsoft Word needs "text" in those fields. If you do not press the Space key, your name and initials will return.

REMOVING PERSONAL DATA IN WORD 2007 (WINDOWS)
1. Click on the Microsoft Office Button and click on the Prepare menu.
2. Click Inspect Document. A Document Inspector window will open.
3. Click Inspect.
4. Click Remove All in the section for Document Properties and Personal Information (NOT Header, Footer, and Watermarks), then click Close.

REMOVING PERSONAL DATA IN WORD 2016 (MAC)
1. From the Tools menu, select Protect Document.
2. Ensure that Remove personal information is checked.
3. Save document again

REMOVING PERSONAL DATA IN WORD 2011 (MAC)
1. From the Word menu, select Preferences.
2. Click on the Security icon.
3. Under Privacy options, ensure that Remove personal information from this file on save is checked, then click OK.

You can also do the following:
1. Open a Microsoft Word 2011 (Mac) document.
2. Click on the word Word within the Menu bar.
3. Choose the Preferences option.
4. The Word Preferences dialog will open.
5. Click on the Security icon, located in the Personal Settings section.
6. The Security window will open.
7. Enable the Remove personal information from this file on save field.
8. Click on the OK button.
9. Save the document.

REMOVING PERSONAL DATA IN APPLE PAGES 5 (MAC)
- From the Pages menu, select Preferences.
- Delete your name if it appears in the Author field.

SUBMITTING DOCUMENTS
- All materials must be submitted online through the Competition Uploads section
  - Each type of submission has its own box. Make sure to upload your documents in the correct places.
  - Allow yourself time to ensure you uploaded the proper files
- Each document must include your packet number.
- Remove personal information. All submissions are anonymous.
● You can only upload one document to each journal. If submitting a resume and statement to a journal, please combine these into a single file for upload.

● When you have finished uploading all documents, click the “Finalize Uploads for This Competition” button.
  ○ If you realize you need to change your uploads, you may also “Unlock Uploads” on this page during your competition period.

● If you have any trouble uploading, you may email your documents to lawwriteon@georgetown.edu. Ensure your files show a timestamp before your individual deadline.

PREFERENCING

● Preferencing means ranking journals in the order you want to join them

● All preferencing is done in the “Journals Preference” section of the Competition site

● Georgetown Law Journal (GLJ) operates via opt-in
  ○ Opt-in is selected for all students by default
  ○ You must click “No” to opt-out of consideration for GLJ
  ○ Placements are made for GLJ before the other journals
  ○ If you opt-in and are placed on GLJ, you will not be placed on any other journal

● Journals other than GLJ are preferenced by moving the journal from the box on the right to the box on the left.
  ○ The journal you place at the top of the left-hand box is your 1st choice, and so on
  ○ You can drag journals up/down to reorder, or move them back to the right-hand box to un-preference them.

● You can preference any journal throughout the overall competition period regardless of your personal deadline. However, you may only submit personal statements during your personal 2-week window.

● You may preference as many or as few journals as you like, but pay attention to your order.

● The higher you preference a journal, the higher your chances of placing on that journal

● Review how each journal weights the competition criteria (case comment, Bluebook, grades, personal statement)

● If a journal weights a “personal statement”, make sure to pay attention to what they specifically request in the letter + prompt on the Materials page.
  ○ Some journals request a required resume and optional personal statement for this criterion. However, if a journal requests only a personal statement, submitting a resume in addition to or instead of the statement will likely hurt your score with that journal.
  ○ If a journal weights a “personal statement” but you do not upload one, you may still preference that journal. However, your overall score for that journal will be hurt because you will have a 0 for the weighted “personal statement” criterion, and your chances of placing on that journal may decrease. Note: You must turn in a Case Comment and the Bluebook and Editing exam to remain in the competition; you may not opt to take a 0 for either of those criterion.
○ If you submit a personal statement for a journal, you must also preference that journal to be considered for membership.

○ If you are not sure at first if you might preference a journal that weights a “Personal Statement”, you might wish to submit one anyway. All “Personal Statement” submissions are due with the other competition materials by your personal deadline. “Personal Statement” submissions will not be accepted after the deadline if you later decide to preference a journal that wants one.

● We will match you to one journal. If, after being offered membership, you decide that you do not wish to be a member of that journal, you may decline membership. You will not, however, be offered any other journal memberships. Thus, you should only preference journals in which you have a sincere interest.

● You will be able to change your preferences until 11:59pm EDT on July 7. Please make sure that your list is final at that time.

● If you are applying or have been accepted to a study abroad program, please review the journals’ policies on studying abroad before you preference (available in the Downloads section and at gtlwriteon.org).

FREQUENTLY ASKED QUESTIONS

● We have included a list of FAQs at gtlwriteon.org and in the Downloads section of the Competition site. We recommend you review those in addition to these instructions.